Watershed Management Plan
HUC 10 Watershed # 0306010403

Broad River (Madison County, Georgia)

March 2014

Prepared by the Northeast Georgia Regional Commission’s Planning and Government Services Division

NEGRC

NORTHEAST GEORGIA
REGIONAL COMMISSION

with the support of the

Environmental Protection Division of the
Georgia Department of Natural Resources

#%% GEORGIA

DEPARTMENT OF NATURAL RESOURCES




Table of Contents

l. Segment and Watershed Description
I. Water Quality Impairments and Total Maximum Daily Loads

Il Visual Surveys and Targeted Watershed Monitoring

V. Identification and Ranking of Significant Sources of Impairments

V. Identification of Applicable Existing Management Measures

VL. Recommendations for Additional Management Measures

VII. Partner Organizations and Advisory Groups

VIII. Milestones & Implementation Schedule

IX. Public Involvement, Education, and Outreach

X. Recommendations for Monitoring and Criteria for Measuring Success
APPENDICES

Appendix A: USEPA Guidelines for Watershed Planning
Appendix B: Field Notes and Pictures

Appendix C: Education and Outreach Materials

Appendix D: Suggestions for Working with Landowners/Managers
Appendix E: Stakeholder List

Appendix F: Micro-watershed Tutorial



Segment and Watershed Description

The impaired segment of the Broad River (SR 281 to Scull Shoal Creek near Danielsville) is five miles in length and is located in the
Savannah River basin in Madison County, Georgia, northwest of the City of Danielsville (Figure 1). The fecal coliform data that listed this
segment were collected in 1997 and 1998, and indicated that the segment is partially supporting its designated use of fishing (EPD now
only classifies segments as supporting or not supporting, and this segment would now fall under the “not supporting” category). E. coli
and fecal coliform data have been collected on a limited basis since 1997-1998. A Total Maximum Daily Load (TMDL) was established for
this segment in 2005. Sources of impairment are nonpoint, and are thought to consist primarily of wildlife and animal production, with
failing septic systems possibly contributing. The TMDL Implementation Plan developed in 2007 indicates that a 69% reduction in pollutant
loading is needed for this segment to meet its designated use of fishing. The Broad River Watershed Association has undertaken E. coli
and fecal coliform monitoring in the watershed at various time periods since the late 1990s.

The watershed for the SR 281-to-Scull Shoal Creek segment is 28,022 acres. Primary land uses in the watershed are forestry/logging,
crop production, and residential, according to 2004 land use data. Forestry/logging accounts for 45%. The primary source of fecal
coliform on forestry land is wildlife, although there may be human sources as well (hunting camps). According to land use data, crop
production accounts for 28% of property in the study area.

However, during a windshield survey conducted in association with this work, animal production was observed much more often than crop
production. It is possible that most of the land classified in the land use data as crop production is in fact used for livestock grazing.
Stakeholders discussed this issue while developing the Broad River Watershed Improvement Plan (WIP, a precursor to this Watershed
Management Plan) first-advisory-meeting, and they agreed that most land characterized as “crop production” is likely used for livestock
purposes. Also, the trend in Madison County has been for cropland to be given over to animal production. Animal production in the
watershed consists primarily of pasture for cattle and horses, and poultry and egg production. Residential land accounts for 18% of the
watershed. All of the residences in the watershed are served by individual septic systems.

Due to the potential discrepancy in the above-referenced land use data, this document also provides a map of land cover in the watershed
(Figure 2), which shows different types of environments and may prove more useful for understanding the true nature of the watershed’s
physical situation.

No water pollution control facilities or known point sources exist along the impaired segment.

Madison County has adopted a soil erosion and sedimentation control ordinance that addresses nonpoint source pollution on newly-
developed lands, as well as a stormwater ordinance to limit and control post-development stormwater runoff. The county’s river corridor
protection ordinance was adopted in 1993. Madison County also has an ordinance allowing for the construction of conservation
subdivisions; that ordinance requires at least 50% of the land in these developments to be kept as greenspace and be put into a
permanent conservation easement. The remaining land will be developed with the same number of residences that would be allowed on
the entire property under standard zoning regulations. Additionally, Madison County has adopted a groundwater recharge protection
ordinance. In 2009, Madison County adopted an ordinance to increase the riparian buffer limit on state waters from 25’ to 50’, with a 100’
buffer on the Broad, South Fork, and Hudson rivers.

Keep Madison County Beautiful led the 2005 and 2006 Rivers Alive cleanup events on the Broad River in Oglethorpe, Madison, and Elbert
Counties, and continues to promote these events. The Broad River Watershed Association is active in Madison County and conducts
educational, outreach, and monitoring events within the watershed. Madison County is located in the Oconee River Resource
Conservation and Development Council (RC&D) region. The RC&D has led EPA 319(h)-funded programs in other counties in the region,
but none have been active in this watershed.
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Water Quality Impairments and Total Maximum Daily Loads

The impaired segment is five miles long and flows from SR 281 to the confluence with Scull Shoal Creek. The pollutant of concern is fecal
coliform, and the impairment is based on the above-referenced data obtained in the 1997-1998 period. The segment was placed on the
Georgia 303(d) list of impaired water bodies as partially supporting its designated use of fishing. (That listing would now be characterized
as “not supporting.”)

The table below provides the water quality sampling data for the Broad River that precipitated its listing on the Georgia 303(d) list.

Table 1: Broad River at SR 281, 1997 Sampling Data

Date Observed Fecal Coliform Date Observed Fecal Coliform Date Observed Fecal Coliform
(counts/100 ml) (counts/100 ml) (counts/100 ml)
1.16.97 5895| 7.15.97 560| 11.26.97 330
2.11.97 460| 7.29.97 330 12.9.97 70
3.11.97 460( 8.4.97 80| 12.17.97 330
4.21.97 410( 8.12.97 220 12.23.97 1100
5.6.97 700 9.9.97 230
6.10.97 375| 10.21.97 490
Source: United States Geologic Survey data form (process date 6/27/99), as referenced in Sampling Quality Assurance Plan for the Broad
River (HUC 10 #0306010403), August 2008

A TMDL was established by the Georgia Department of Natural Resources’ Environmental Protection Division for two impaired segments
of the Broad River in 2005. The associated report, Total Maximum Daily Load Evaluation for Thirty-Two Streams in the Savannah River
Basin for Fecal Coliform, indicates that a 69% reduction in fecal coliform loads is required for this stream to achieve standards for its
designated use.

Table 2: 2005 TMDL Evaluation Data

TMDL Components

Stream Segment Current Load WLA WLASW LA MOS TMDL _percent
(counts ays) | (counts/30 | (counts/30 | (counts/30 | (counts/30 | (counts/30 eauction
days) days) days) days) days)

Broad River — SR 281 to Scull Shoal

. . 1.13E+16 3.12E+15 3.46E+14 3.46E+15 69
Creek near Danielsville

As of the beginning of this Watershed Management Plan development process, the source of the impairment was unknown. The TMDL
Implementation Plan speculated that the source could be wildlife, animal production, and/or failing septic systems. Preliminary WMP
sampling data revealed several “hot spots.” Initial discussions with stakeholders helped identify several potential contamination sources
that merit further investigation. In an effort to better isolate potential sources, new sites were added to the sampling inventory and others
were removed from the current sampling list.



[l Visual Surveys and Targeted Watershed Monitoring

A visual field survey was conducted in February 2009 and further site visits were conducted in 2011 and 2013. Water quality sampling
was initiated in May 2011 under a Targeted Monitoring Plan that identified seven locations for E. coli monitoring under the plan.

Monitoring was recommenced in March 2013 with a new set of sampling locations, and has taken place at each location monthly in an
effort to geographically isolate the major sources of impairment. Due to the presence of consistent “hot spots” and other areas where
readings did not appear to be a concern, the sampling site locations evolve over time.

Escherichia coli are rod-shaped bacteria that live in the lower intestines of warm-blooded mammals. They are necessary for the proper
digestion of food, but their presence in surface water indicates fecal contamination. E. coli belongs to a group of bacteria (some of which
are harmful) known as fecal coliform bacteria. E. coli itself cannot cause illness unless it is introduced into an open wound or the urinary
tract.

Table 3: Sampling Stations

Station Number General Location Latitude Longitude Sample Parameters
1A Broad R. at US 29 34.23977 -83.17921 E. coli
1 Broad R. at SR 281 — access at Broad River Outpost (GAEPD site) 34.180868 | -83.145808 | E. coli
1B Broad R. at SR 172 34.15651 -83.08291 E. coli
2 Shiloh Cr. at Manley Martin Rd. (downstream) 34.220484 | -83.176817 | E. coli
3 Trib. to Shiloh Cr. downstream of US 29 34.219803 | -83.187942 | E. coli
3A Shiloh Cr. at US 29 (downstream) 34.220035 | -83.189993 | E. coli
4 Shiloh Cr. at Holloway Rd. (upstream) 34.212195 | -83.201639 | E. coli
4A1 Shiloh Cr. upstream of Holloway Rd. (downstream site at farm) 34.214642 | -83.203933 | E. coli
4A2 Shiloh Cr. upstream of Holloway Rd. (upstream site at farm) 34.214642 | -83.203933 | E. coli
4B Shiloh Cr. along Long Peeples Rd. 34.218019 | -83.192211 | E. coli
4C Branch of Shiloh Cr. at Holloway Rd. (ditch draining wetland) 34.212236 | -83.201519 | E. coli
5 Scull Shoal Cr. at Davids Home Church Rd. (downstream) 34.155858 | -83.099936 | E. coli
6 Little Scull Shoal Cr. at Duffell Martin Rd. (upstream) 34.152515 | -83.121335 | E. coli
6A Little Scull Shoal Cr. at Winns Lake Rd. 34.147525 | -83.128144 | E. coli




Table 3: Sampling Stations

Station Number General Location Latitude Longitude Sample Parameters
7 Scull Shoal Cr. at Transco Rd. (upstream) 34.158695 | -83.149622 | E. coli
T7A Scull Shoal Cr. upstream of Transco Rd. 34.158769 | -83.149478 | E. coli
7A Alt. Scull Shoal Cr. at SR 191 (upstream) 34.158519 | -83.164258 | E. coli
8 Little Scull Shoal Cr. at Coile Rd. 34.13284 -83.13693 E. coli
9 Little Scull Shoal Cr. at Lystra Church Rd. 34.11873 -83.14754 E. coli
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Water quality sampling provided the following data for each of the sampling locations (figures in colony-forming units, CFU):

Site 3/13 5/13 6/13 7/13 9/13 9/13 10/13 11/13 12/13
1A 67 133 233 200
1 200 200 233 133 633 200 100 233 166
1B 167 100 33 200
2 866 800 800 700 833 1470 567 547 633
3 233 666 367 600 1533 667 633 367 367
3A 67 566 367 433 333 500 700 433 667
4 1 200 267 100 166 67 333 233 200
4A1 1 500 567 633 333
4A2 100 366 100 133 200
4B 67 566 667
4C 133 266 367 233 467 267 533 167 100
5 366 666 500 166 1133 300 267 167 667
6 1166 1400 1467 333 2233 400 433 400 2833
6A 800 1700 1467 1000 2033 167 567 267 3067
7 200 300 633 300 500
7A Alt 233 333 233 500 300
8 833 800 700 5500
9 1 67 233 333

10



US EPA fecal coliform assumes 60% of a fecal coliform most probable number (MPN) is E. coli. Calculating this ratio, as shown below, yields results that
can be evaluated against the fecal coliform standard.

May - October November - April
Geometric means not to exceed 200 MPN/100 mi Geometric mean not to exceed 1,000 MPN/100 ml
No individual sample exceeding 4,000 MPN/100 ml No individual sample exceeding 4,000 MPN/100 ml.
Site 3/13 5/13 6/13 7/13 9/13 9/13 10/13 11/13 12/13
1A 112 222 388 333
1 333 333 388 222 1055 333 167 388 277
1B 278 167 55 333
2 1443 1333 1333 1167 1388 2450 945 912 1055
3 388 1110 612 1000 2555 1112 1055 612 612
3A 112 943 612 722 555 833 1167 722 1112
4 2 333 445 167 277 112 555 388 333
4A1 2 833 945 1055 555
4A2 167 610 167 222 333
4B 112 943 1112
4C 222 443 612 388 778 445 888 278 167
5 610 1110 833 277 1888 500 445 278 1112
6 1943 2333 2445 555 3722 667 722 667 4722
6A 1333 2833 2445 1667 3388 278 945 445 5112
7 333 500 1055 500 833
7A Alt 388 555 388 833 500
8 1388 1333 1167 9167
9 2 112 388 555

11



V. Identification and Ranking of Significant Sources of Impairments

The TMDL Implementation Plan for the Broad River identifies the following sources of contamination:
Table 4: TMDLIP Potential Source Ranking for the Broad River

IMPACT
POTENTIAL SOURCES ESTIMATED EXTENT OF CONTRIBUTION ESTIMATED PORTION OF CONTRIBUTION RATING
Comments Rating (A) Comments Rating (B) (A X B)
Wildlife Forestry/logging is 45% of 3 Forestry/logging adjacent to stream 3 9
watershed land use segment
Animal Production Animal production is 7% of 3 Animal production in close proximity 1 3
watershed according to land use to tributaries but not TMDL segment
data, but likely to be a lot more
Failing Septic Systems Residential is 18% land use 1 Several residential parcels adjacent to 1 1
TMDL segment
lllegal Dumping UNK UNK UNK

Based on data obtained and analyzed under the WMP development process, the table above seems to underestimate Animal Production as a
significant concern, particularly regarding the statement, “Animal production in close proximity to tributaries but not TMDL segment.” While it is

true that the areas surrounding the tributaries are the primary location of animal production, their impact on the watershed should not be

discounted or underrepresented. Additionally, stakeholders indicate that the land cover data from which the previous table is derived are likely in
error. They note that a large part of the watershed that was previously characterized as forestry/logging is actually agricultural (in fact, they
suggest that the plurality of land in the watershed is agricultural, with much of this based in animal production).

The following Revised Potential Source Ranking is presented:
Table 5: Revised Potential Source Ranking for the Broad River

IMPACT
POTENTIAL SOURCES ESTIMATED EXTENT OF CONTRIBUTION ESTIMATED PORTION OF CONTRIBUTION RATING
Comments Rating (A) Comments Rating (B) (A XB)
Wildlife Forestry/logging is not a primary 2 Unknown — bacterial source-tracking 1 2
land use in the watershed, but would be helpful
wildlife may populate other land
areas
Animal Production Animal production is thought to be 3 Animal production in close proximity 3 9
the predominant use of land to tributaries but not TMDL segment
Failing Septic Systems Residential is 18% land use 1 Several residential parcels adjacent to 3 3
TMDL segment; potential exists for
failing septic
lllegal Dumping UNK UNK UNK

To better understand the exact area drained by each sampling point (and, thereby, the specific physical properties from which runoff could reach
the monitoring sites), NEGRC staff developed a model to divide the larger watershed into “micro-watersheds” (MW). These MWs are defined not
only by the land upstream of the sampling points, but also by topographic features that dictate where water drains. Just as larger watersheds are
defined by topography, likewise, these MWs are delineated based on high elevations (ridge lines, for example), and they provide precision far
greater than simply examining land upstream from the monitoring locations.

12




Through targeted monitoring associated with this WMP, stakeholders and planners identified several “hot spots” that likely contribute to fecal
contamination within the watershed. Those points of significant contamination, with detailed descriptions of the land area contained in their MWs,

are as follows:
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Chicken houses exist
within the MW, but their
immediate operation
should not be problematic,
as stakeholders indicate
that appropriate BMPs are
in use. Rather, the
spreading of chicken litter
on fields would be
potential cause for
concern if stack houses
are not used to reduce
coliforms prior to
spreading. The terrain
slopes relatively steeply
from the chicken houses to
the creek, and substantial
litter has been
documented here by
sampling volunteers.

Cows were documented in
the creek by sampling
volunteers, across the
stream from the chicken
houses. Parcels 062 082,
062 083, and 062 079 are
of concern.
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Cows in these MWs have creek access,
and chicken litter was also observed
within the areas, although it is unknown
whether the litter was/is stacked for
sufficient time (extension agent
recommends eight days or more) prior to
spreading.
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Winns Lake was a pay-to-
catch lake until
approximately 10 years
ago; the smaller, colored
ponds observed on the
aerials could be/have been
hatcheries. A significant
amount of this MW lies in
pasture, and many houses
on septic systems are also
present.



8 Little Scull Shoal Cr. at Cile Rd.

Monitors observed
hundreds of cows in and
around a pond on parcel
081 040 during the
December 2013 sampling
event. Septic also may be
worth examining here —
many homes are situated
along the road.
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V. Identification of Applicable Existing Management Measures

The following measures are among those that were identified in the TMDLIP:

Table 6: TMDLIP Existing Management Measures

Handlers Rules of
Georgia
Department of
Agriculture Animal
Industry Division

on public roadways, or depositing animal manure to a premise other
than its point of origin obtain a permit and follow rules to control
animal disease, and outlines regulations for transportation,
equipment and storage.

BEST SOURCES OF | STATUS | TARGET
MANAGEMENT | RESPONSIBILITY DESCRIPTION FUNDING & CODE DATE
PRACTICE RESOURCES
Federal Clean USEPA, The congressional objective of the CWA “is to restore and maintain Federal, State A In place,
Water Act, Section | Georgia DNR/EPD, the chemical, physical, and biological integrity of the Nation’s On-going
305(b) and 303(d) | Local/County waters.” Section 305 (the National Water Quality Inventory)
Government requires states to report progress in restoring impaired waters to
EPA on a biennial basis. Section 303(d) requires states to identify
‘impaired’ waters, submit a list to EPA every two years, and develop
TMDLs for these waters.
Georgia Water Georgia Rules and Law prohibiting discharge of excessive pollutants (sediments, Federal, State, A In place,
Quality Control Act | Regulations for nutrients, pesticides, animal wastes, etc.) into waters of the State in | Local/County on-going
(OCGA 12-5-20) Water Quality amounts harmful to public health, safety, or welfare, or to animals, Governments
Control, Chapter birds, or aquatic life or the physical destruction of stream habitats.
391-3-6 Law authorizing Georgia EPD to control water pollution, eliminate
phosphate detergents and regulate sludge disposal; to require
permits for agricultural ground and surface water withdrawals; to
prohibit siltation of state waters by land disturbing activities and
require undisturbed buffers along state waters; to require land-use
plans that include controls to protect drinking water supply sources
and wetlands; to require river basin management plans on a rotation
schedule for all major river basins.
Georgia Planning NEGRDC, Madison | Coordinated Planning Program, managed by Georgia DCA requires | Local/County A In place,
Act, Part 5 County local governments to identify Developments of Regional Impact Governments on-going
(DRI) and develop plans to protect and manage Regional Impact Impact Fees
Resources (RIR).
Post-Development | Madison County Stormwater ordinance complies with NPDES Phase I, which Madison County | A 2006
Stormwater wouldn’t have been required until after 2010. Requires post
Ordinance development storm water BMPs for land disturbing activities that
create 5,000 square feet of impervious surface or that involve land
development of 1 acre or more.
Development Madison County Creates point system for approval of development. Must have 200 A
Standards points for approval. Different development practices worth different
Program number of points. Some practices involve increasing or maintaining
tree cover and greenspace.
Rivers Alive Keep Madison Annual river cleanup. Keep Madison Beautiful leads volunteer effort A Ongoing
Beautiful on Broad River in Elbert, Madison and Oglethorpe Counties.
lllegal Dumping Madison County Develop ordinance forbidding illegal dumping of waste, place no A In place,
Programs dumping signs, and allow for citizen reporting of illegal dumping. on-going
Chapter 40-13-8 Georgia Department | This requires that persons engaged in removing animal manure State R In place,
Animal Manure of Agriculture from livestock/poultry production areas, transporting animal manure on-going
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Table 6: TMDLIP Existing Management Measures

BEST SOURCES OF | STATUS | TARGET
MANAGEMENT | RESPONSIBILITY DESCRIPTION FUNDING & CODE DATE
PRACTICE RESOURCES
Conservation Natural Resources Provides technical assistance, rental payments and cost share Federal A
Reserve Program Conservation funding to address specific natural resource concerns including: Annual rental
(CRP) Services / USDA protection [of] ground and surface waters, soil erosion and wildlife payment for land
Farm Services habitat. Eligible practices include tree planting, grassed waterways, | taken out of
Agency wildlife habitat buffers, and shallow water area for wildlife and filter production and
strips. 50% cost share
for practice In place,
installation. on-going

Status Codes: (A) installed and active; (R) required by law, regulation, or permit conditions

VI. Recommendations for Additional Management Measures
Stakeholders developed the following goals for the project and the watershed:

1. Pinpoint sources of contamination and improve water quality
2. Delist the Broad River as an impaired stream with the State of Georgia
3. Build community among stream advocates, landowners, and government officials

In addition to the existing management practices listed previously, further potential BMPs were evaluated for consideration as final recommended
BMPs. The potential management practices apply to agricultural, forested, and residential land, and were evaluated against the goals for the
project. Based on the micro-watersheds previously described, the revised Potential Source Ranking, and the project’s goals, planners examined
the nature of the land drained by each problematic sampling point. This allows for an analysis of property based on the following characteristics of
each MW identified as problematic:

Presence of cows and cow pasture

Ability of cows, if present, to access streams or ponds

Presence of chicken houses

Presence of ponds (or similar)

Presence of residential homes, particularly with regard to septic systems
Presence of forested land

Topography

The highest-rated management practices are presented further in the document as final recommended best management practices (BMPs).
Sources of information include:

Effectiveness of Best Management Practices for Bacteria Removal, Emmons & Oliver Resources (http://www.pca.state.mn.us/index.php/view-
document.html?gid=16328); National Management Measures to Control Nonpoint Source Pollution from Agriculture, US EPA
(www.epa.gov/owow/nps/agmm/index.html); Agricultural Best Management Practices for Protecting Water Quality in Georgia, Georgia Soil &
Water Conservation Commission (http://www.gaepd.org/Files PDF/techguide/wpb/Agriculture Best Management Practices March 2007.pdf);
The University of Georgia Cooperative Extension Service

18
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Table 7: Potential Management Practices

Management Practice

Definition

Estimated
Effectiveness*

Estimated Load
Reductions*

Land Use

Wetland treatment systems

Treating wastewater and storm water inputs

79%

Low (costly,
unlikely to be
implemented)

Agriculture/Forested

implemented on
a large scale)

Limiting livestock access to Providing alternative water and shade for High High Agriculture

riparian areas livestock

Apply litter based on nutrient Reduces the over application of litter Low Low Agriculture

needs of crops

Detention and Retention Ponds | Allows for sediment containing bacteria to Wet 15-20% Medium Agriculture
settle out of runoff Dry 90%

Bio-filtration/Filtration Filters runoff trough a medium of sand, gravel, | 92% Low (costly, Agriculture/Forested
and/or compost unlikely to be

concentration

Vegetated buffers/Filter Filters out sediment containing bacteria Dependent on High Agriculture
strips/Swales size and length
Manure management Methods to better transport, store, use, and Unknown Medium Agriculture
treat
Pollution prevention and source | Pet waste control, septic maintenance, street Medium Low Agriculture/Forested
controls sweeping, wildlife management /Urban
Stormwater runoff controls for Applying stormwater quality standards; enact >75% Low (little Urban
new development, existing Phase | and || NPDES Stormwater Permit impervious
development, and requirements for pollution prevention surface in
redevelopment (Compliance watershed)
with local ordinances and state
regulations)
Prevent and/or manage spills, Enact Phase | and Il NPDES Stormwater 25-50% Medium Urban
illicit discharges, and Permit requirements for illicit discharge
wastewater system problems detection and elimination
Monitoring malfunctioning Monitor for failures and promote cleanout Clean-out 10- Medium Urban
septic tanks procedures 25%
Failure
detection 50-
75%
Agricultural water conservation | Reduce runoff, erosion, etc., and increase Unknown Medium Agriculture
stream dilution
Stack houses for poultry litter Encourage stacking or composting of litter prior | High Medium Agriculture
to land application to reduce risk for bacteria
loading
Nutrient management and Nutrient application and soil management High Low Agriculture
erosion control
Wildlife management Address wildlife overpopulation and Medium Medium Forest

19




Table 7: Potential Management Practices

Management Practice Definition Estimated Estimated Load | Land Use
Effectiveness* | Reductions*

Educational programs and Education for general public Medium Medium Urban/Agriculture/

materials Forested

Stream bank restoration Diffuse runoff and erosion as well as provide Low Low Forested
buffer for streams

Animal mortality facilities Disposal of animal carcasses Unknown Low Agriculture

Stream crossings Concentrates animal/livestock crossing over High Medium Agriculture
structure

Riparian herbaceous Reduce runoff, erosion, etc. Medium Medium Agriculture

cover/Forest buffer /Forested

Prescribed grazing Manage grazing of livestock across fields to Medium Medium Agriculture

reduce erosion

*Estimated Effectiveness refers to the MP’s ability to reduce contamination in concept; Estimated Load Reductions apply that effectiveness to this
watershed (in particular, to the selected MWSs).

AGRICULTURAL BMPS

Wetland Treatment Systems

Wetland constructed for the sole purpose of treating wastewater and stormwater inputs. The cons associated with this MP are that there has been
evidence of increased levels of bacteria from the outfall of the wetland compared to what enters the wetland. Constructed wetlands are successful
at allowing the sediment and bacteria to settle. However, the presence of waterfowl and other wildlife may cause increases in bacteria leaving the
system. On average, as taken from several sources, the removal effectiveness was 79%.

Limiting Livestock Access to Riparian Areas and Streams
Best implemented when producers have alternative water sources and shade for their livestock

Apply Litter Based on Nutrient Needs of the Crops with the Nutrient Content of the Litter
This helps prevent over-application of litter. Also, the time of litter application should be managed so as to not precede a rain event.

Detention and Retention Ponds

Ponds constructed to allow for the settling of particles captured by runoff. This type of MP would include sedimentation ponds. Removal
effectiveness in wet retention ponds, on average from varying sources, is about 15-20%. Removal effectiveness in dry retention ponds are, on
average, about 90%. Dry retention ponds differ from wet ponds as they drain completely dry and only store water temporarily. In some cases,
bacteria level increases in the outflow compared to the input may be associated with sediment washed out by storm events.

Bio-Filtration/Filtration

This management practice allows stormwater to flow through a medium of sand, compost, or soil, or a combination thereof, to filter out sediment.
Removal effectiveness of bacteria is, on average, around 92%.
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Vegetated Buffers/Filter Strips/Swales
Strips of vegetation next to an area of runoff. The runoff flows over the buffer or filter strip to allow sediment to be captured and allow water to be
filtered into the soil. The effectiveness in removing bacteria is dependent on the size and length of the strip.

Manure Management
Methods to better store, use, and treat manure to limit the potential for bacteria to be transported into water.

Pollution Prevention and Source Controls
Limit the introduction of bacteria into locations in the landscape that could possibly allow for the transport into rivers or riparian zones. Pet waste
control, septic maintenance, street sweeping, and wildlife management are examples.

Agricultural Water Conservation
Limit the use of water for irrigation of crops and fields. Reducing water use can reduce the occurrence of runoff from contaminated fields and
allow for water to infiltrate the soil.

Stack Houses for Poultry Litter

This will be a long-term objective, promoting such structures and supporting efforts to make them affordable/available to area farmers. Poultry
farming is prevalent locally, and the litter byproduct can prove difficult to process or dispose, either on- or off-site. Stack houses provide an
effective means for storing and managing chicken litter and might minimize the volume of litter applied on local fields. Estimated effectiveness is
medium with a percent load reduction of 10%. Poultry growers should consider stacking broiler litter for more than eight days to eliminate fecal
coliforms in runoff from land-spread litter.

Nutrient Management and Erosion Control

This is the catch-all category for on-site property improvements and best management practices designed to mitigate the ability of cultivated soil
amendments to wash off fields and find their way into the stream. This can include setbacks, nutrient management, swales and landscaping or
other measures. All such measures should be done according to the latest standards advised by NRCS, and should be pursued in coordination
with an overall improvement plan for the subject property.

Animal Mortality Facilities
Permanent structures used to dispose of carcasses, including burial pits, mortality composting facility, incinerators, and freezers. MP can improve
soil and water quality.

Stream Crossings

Designed to protect water quality and erosion by concentrating animal and livestock crossings over stable access points or structures. This
management practice can be paired with other practices including designated animal trails to further reduce erosion of contaminated soil and
sediment.

Riparian Herbaceous Cover/Forest Buffer
Use shrubbery or grass-like vegetation to act as a filter for sediment transport into waterways.

Prescribed Grazing

Maintain vegetative cover and soil management by limiting grazing by animals and livestock. Reduces sediment runoff by allowing vegetation to
continue to grow and prevent fields from being overgrazed.
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URBAN BMPS

Stormwater Runoff from New Development, Existing Development, and Redevelopment

Enact required post-construction stormwater quality management practices and amend/create local land development codes and ordinances for
the implementation of stormwater quality management practices for new and redeveloped areas (new development and redevelopment). Enact
Phase | and Il NPDES Stormwater Permit requirements for pollution prevention and good housekeeping in permitted developed areas, and
voluntarily enact such measures in unpermitted developed areas (existing development). Overall effectiveness in reducing contaminants in
stormwater runoff should exceed >75% in reduction. Voluntary housekeeping activities should achieve about 10% reduction in contaminants in
runoff.

Prevent and/or Manage Spills, lllicit Discharges, and Wastewater System Problems

Enact Phase | and Il NPDES Stormwater Permit requirements for illicit discharge detection and elimination in permitted developed areas.
Voluntarily enact such measures in unpermitted developed areas. Apply specific operation and maintenance BMPs listed in the Metro North
Georgia Water Planning District Watershed Management Plan to existing development. Application of required illicit discharge detection and
elimination activities should achieve a 25-50% reduction in all major contaminant loads from spills, illicit discharges, and wastewater leaks in areas
where applied.

Monitoring Malfunctioning Septic Tanks

Enact septic tank cleanout program ordinances and septic tank failure detection and correction programs or ordinances. Required cleanout
programs should achieve 10-25% reductions in pathogens and nutrient loads. Failure detection and correction programs should achieve a 50-
75% reduction.

Educational Programs and Materials

Communities employ various methods to engage area residents, employers, and developers on the rules and efforts behind maintaining local
water quality. A specialized approach for the watershed could aid in this effort by providing targeted information to critical stakeholders, building a
stronger sense of vested interest among property owners and business owners, and increasing awareness of and support for BMPs and mitigation
measures. This could include promotional materials illustrating the health of the watershed and special guidance about WMP-related activities and
issues.

FORESTRY BMPS

Wildlife Management

This is the general term for measures designed to address animal overpopulation or the concentration and infiltration of specific animals into
streams and lakes. This can include the forced removal of animals, the introduction of measures to deter animals, or adjustments in hunting
policies.

Stream Bank Restoration

This is a landscaping and engineering effort to restore the integrity of declining stream banks. Shorelines prone to washouts and erosion issues
often need structural repair, and these singular engineering projects can repair the bank’s ability to treat and slow stormwater runoff, as well as
aiding shade conditions and litter control.
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Potential BMPs were evaluated against the following criteria to determine their likely utility with respect to lowering bacterial contamination within
the watershed, allowing for an analysis of property based on the identified problematic MWs:

e Location, especially with respect to proximity to problematic MWs and streams, physical factors such as topography, and use of land (e.g.,
presence of cows and pasture, chicken houses, litter, ponds, septic tanks, forested land, etc.)

o Estimated effectiveness and load reduction

¢ Community acceptance

Final recommended BMPs are:

Table 8: Final Recommended Best Management Practices Ranking

Management Practice Location, Physical | Estimated Community Average and Comments
Factors, and Use Effectiveness and Acceptance (Rank
of Land (Rank 1-5) | Load Reduction 1-5)
(Rank 1-5)
Educational programs and 5 4 5 4.7 — Producers and homeowners
materials may simply not be aware of the issues

4.3 — High-impact BMP; producers
5 5 3 used to allowing cattle unfettered
access to streams might be resistant

Limiting livestock access to riparian
areas

4.3 — Effective with any type of
4 5 4 agriculture, including cattle production
and spreading of chicken litter

Vegetated buffers/Filter
strips/Swales

3.7 — Extent of use of unstacked litter

Stack houses for poultry litter 3 4 4 is unknown

3.3 — Not thought to be as widespread

Monitoring malfunctioning septic 2 4 4 an issue as agriculture, but highest-

tanks impact “urban” BMP
3.3 — Wildlife not thought to be

Wildlife management 5 3 5 primary contributor to contamination;
geese and feral hogs are the most
likely concerns

Stream crossings 3 4 3 3.3 — Could be cost-prohibitive in

some situations, but highly effective
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VII. Partner Organizations and Advisory Groups

Table 9: Partnership Advisory Council

Name Organization Name Organization
Brenda Bailey Broad River Watershed Association | Rick Kelly Broad River Watershed Association
Michael Moody Broad River Watershed Association | Victor Johnson Broad River Watershed Association
Tom Krobot Broad River Watershed Association | Carly Robinson Camp Kiwanis
Ellen Forbus Broad River Watershed Association | Adam Speir Madison County Extension
Ken Forbus Broad River Watershed Association | Linda Fortson Madison County Planning & Zoning
Jean Smith Broad River Watershed Association | Jack Huff Madison County Code Enforcement
Sam Linhart Broad River Watershed Association | Johnny Bridges Madison County Emergency
Pat Kelly Broad River Watershed Association Management Agency

These partners will be essential to developing a successful implementation program for this project. For example, as part of an application
process for funding desired improvements, stakeholders will be asked to outline potential contributions they can make to the undertaking. These
would include professional and/or technical assistance, cash or in-kind services, supplies and materials, volunteer labor, and other resources. The
local government(s), the Northeast Georgia Regional Commission, the Georgia EPD, the Broad River Watershed Association, the University of
Georgia, local schools, and the Oconee River RC&D should be relied upon for assistance, as should individual landowners whose property could
directly affect water quality. Since a specific scope of improvements has not been developed, a budget is currently unavailable.

VIII. Milestones & Implementation Schedule

Table 10: Milestones & Implementation Schedule

Activity Target Date Responsible Party
Continue monitoring to refine understanding of contamination sources Ongoing BRWA, GAEPD, NEGRC (contingent
upon funding availability)
Evaluate potential for applying for 319(h) funds to implement BMPs and continue watershed Fall 2014 Madison County, BRWA, Oconee River
monitoring RC&D, NEGRC, GAEPD, Stakeholders
Apply for 319(h) funding, if applicable. If funding is applied for and received, city/county Next cycle Madison County, BRWA, Oconee River

deadline (2013 | RC&D, NEGRC, GAEPD, Stakeholders
deadline was
10/31)

government, BRWA, Oconee River RC&D, NEGRC, GAEPD, and/or stakeholders will need to
determine other steps and milestones necessary to successfully fulfill the grant’s goals and
scope. See below for specific timeline information on implementation schedule for Final
Recommended BMPs.
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Table 10: Milestones & Implementation Schedule

Activity Target Date Responsible Party
Open communication with health department to identify potential for a review of potentially 2014-2015 Madison County, BRWA, GAEPD,
problematic septic systems Stakeholders

Work with GAEPD to remove (if applicable) the Broad R from the contaminated waters list while |Long-range Madison County, BRWA, GAEPD,
focusing attention on problematic tributaries Stakeholders

Implementing the Final Recommended Best Management Practices found in section VI of this document is a critical component of improving the
watershed. The following table outlines an implementation program specific to the BMPs:

Table 11: Final Recommended Best Management Practices Implementation Program

Management Practice Implementation Timeline Responsible Implementing | Potential Funding Source
Entity(ies) (see following for more information)

Educational programs and materials Ongoing (begin immediately) | BRWA, Local government, 319 Program, NIWQP, EE
NEGRC, EPD, other Grants
organizations

Limiting livestock access to riparian areas Mid-Term (2-5 years) Producers 319 Program, NIWQP, AMA,

EQIP

Vegetated buffers/Filter strips/Swales Mid-Term (2-5 years) Producers and other 319 Program, NIWQP, AMA,
landowners EQIP

Stack houses for poultry litter Long-Term (5-plus years) Producers 319 Program, NIWQP, EQIP

Monitoring malfunctioning septic tanks Short-Term (<2 years) Homeowners, business 319 Program, NIWQP, EQIP
owners, and health
department

Wildlife management Mid-Term (2-5 years) Landowners 319 Program

Stream crossings Long-Term (5-plus years) Producers 319 Program, NIWQP, EQIP




FUNDING SOURCES

Agricultural Management Assistance (AMA)
Provides cost-share assistance to agricultural producers to voluntarily address issues such as water management, water quality, and erosion

control by incorporating conservation into farming operations.

Environmental Education Grants (EE Grants)
USEPA seeks grant proposals from eligible applicants to support environmental education projects that promote environmental stewardship and
help develop knowledgeable and responsible students, teachers, and citizens.

Environmental Quality Incentives Program (EQIP)

The USDA Natural Resources Conservation Service’s EQIP provides financial and technical assistance to agricultural producers in order to
address natural resource concerns and deliver environmental benefits such as improved water and air quality, conserved ground and surface
water, reduced soil erosion and sedimentation, and improved or created wildlife habitat.

National Integrated Water Quality Program (NIWQP)
NIWQP provides funding for research, education, and extension projects aimed at improving water quality in agricultural and rural watersheds.

Nonpoint Source Implementation Grants (319 Program)
Through its 319 program, USEPA provides formula grants to implement nonpoint source projects to protect source water areas and the general
quality of water resources in a watershed, including BMP design, implementation, and installation, as well as education.

IX. Public Involvement, Education, and Outreach

A Partnership Advisory Council was formed to solicit input from a variety of stakeholders, including government elected officials and staff, property
owners, academic researchers, and others. Continued engagement of stakeholders and the general public is recommended to implement the
plan. This should include an education/outreach component that deals with water quality, the relationship between nonpoint source pollution and
stormwater runoff, and other key components.

Additionally, the following programs are recommended for consideration by stakeholders as potential education and outreach tools:
e Green Schools Initiative
e Georgia Adopt-a-Stream continued monitoring
e Rivers Alive and other stream clean-up events
e Storm drain marking
e Septic system awareness and maintenance
e Water conservation
e Festivals and other similar events promoting water quality education across all ages
e Paddling and walking events on and along the river to build awareness and build connections within the watershed
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X. Recommendations for Monitoring and Criteria for Measuring Success

Since “hot spots” of increased contaminant load (within the previously documented problematic micro-watersheds) will exhibit unique causes (e.qg.,
while septic systems may be to blame at one location that has exhibited high readings, livestock may be the prime contributor at another), it is
important to monitor stream conditions before, during, and after initiation of corrective measures, and to install location-appropriate BMPs.
Sampling points should be identified to isolate particular sources and locales from one another; these points might differ from the locations
monitored during the development of this WIP.

If sufficient funding is available, this would be an excellent opportunity to introduce the use of bacterial source tracking. Because BST provides an
understanding of the type of pollutant source (human, livestock, wildlife), it could become an integral part of both appropriate BMP installation and
post-BMP monitoring: as a BMP that targets a particular source type is implemented, stakeholders could use data to confirm or deny the efficacy
of the new measures.

Monthly monitoring using the Georgia Adopt-a-Stream protocols has been a successful, manageable, and affordable resource for this project; it
should be continued unless other more accurate, frequent, or otherwise desirable methods are identified. Aside from data that characterize
stream conditions, it would be advisable to monitor the utility and effectiveness of less quantitative measures, such as education and outreach.

Thus, the criteria that should be used to measure success in this project should include:

Long-Term Water Quality Monitoring — A complete sampling strategy will include both general watershed testing and site-specific
monitoring that gauges the effectiveness of BMP installations.
o Measure: stakeholders/monitors will develop a QA/QC Monitoring Plan that identifies the number/location of sites, sampling
protocols, and data reporting procedures

BMP Implementation (Physical) — Develop BMPs relating to physical property improvements and/or land use practices that reduce the
impact of pollutants on water quality. While implementers should encourage application of BMPs throughout the watershed, funding
assistance should target “hot spots” first, and then be directed elsewhere.
o Measure: approach landowners/managers within each identified problematic micro-watershed, with the intended result of
implementing relevant BMPs on the associated property
= In predominantly agricultural areas, the measure for success is at least one landowner/manager per MW
= In predominantly non-agricultural areas, the measure for success is at least three landowners/managers per MW

BMP Implementation (Programmatic) — Ensure that the “Educational programs and materials” BMP developed in this WMP is applied
throughout (and, if applicable, beyond) the watershed.

o Measure: deliver at least one presentation per quarter on water quality and recommended BMPs to interested groups

o Measure: distribute promotional/educational materials at no fewer than three events yearly

o Measure: send at least 100 mail-outs yearly, targeted specifically to the problematic MWs first, and then to a wider area

The steps presented in this plan should be refined during the process of implementing management measures; they will need to be tailored to
individual sites, landowner preferences, resource availability, and the willingness of decision makers to embrace them. A targeted reduction of
approximately 10% of fecal coliform would be a reasonable expectation to associate with these improvements.

In summary, and according to the USEPA Guidelines for Watershed Planning (Appendix A), the milestones described in Chapter VIII of this
document should be used to outline a schedule and timeline for improvements; any additional criteria that relate directly to the preferred
alternatives should be established, if applicable, to determine whether substantial progress is being made; and stakeholders should continue
monitoring to evaluate the effectiveness of implementation measures.
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Appendix A

USEPA Guidelines for Watershed Planning

(9 Key Elements)
Web Access to Section 319 (h) Application Guidelines:
http://www.gaepd.org/Documents/epdforms wpb.html#nps

GA EPD recommends that the Watershed Management Plan include the following elements to
comply with USEPA Guidelines:

1)

2)

3)

4)

5)

6)

7

8)

9)

An identification of the sources or groups of similar sources contributing
to nonpoint source pollution to be controlled to implement load allocations
or achieve water quality standards. Sources should be identified at the
subcategory level with estimates of the extent to which they are present in
the watershed (e.g., X numbers of cattle feedlots needing upgrading, Y
acres of row crops needing improved sediment control, or Z linear miles
of eroded stream bank needing remediation);

An estimate of the load reductions expected for the management
measures described under paragraph (3) below;

A description of the NPS management measures that will need to be
implemented to achieve the load reductions established in the TMDL or to
achieve water quality standards;

An estimate of the sources of funding needed, and/or authorities that will
be relied upon, to implement the plan;

An information/education component that will be used to enhance public
understanding of and participation in implementing the plan;

A schedule for implementing the management measures that is
reasonably expeditious;

A description of interim, measurable milestones (e.g., amount of load
reductions, improvement in biological or habitat parameters) for
determining whether management measures or other control actions are
being implemented;

A set of criteria that can be used to determine whether substantial
progress is being made towards attaining water quality standards and, if
not, the criteria for determining whether the plan needs to be revised,;
and,;

A monitoring component to evaluate the effectiveness of the
implementation efforts, measured against the criteria established under
item (8).
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Appendix B

Field Notes and Pictures

This section of the appendix includes reports on the Tributary Stream Walks conducted in 2009
and 2013.

These documents follow.
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Appendix B: Field Notes and Pictures

APPENDIX

Broad River (SR 281 to Scull Shoal Creek near Danielsville)
Tributary Stream Walk
February 10, 2009 and March 2013 (updates italicized)

Broad River Watershed Association (BRWA)
Georgia DNR Environmental Protection Division (Georgia EPD)

- Watershed Protection Branch, TMDL Implementation Program
Georgia DNR Wildlife Resources Division - Law Enforcement Section
Madison County - Code Enforcement
Northeast Georgia Regional Commission (NEGRC)

l. Targeted Watershed Monitoring -- Data Summary

The Broad River Watershed Association collected and tested in-stream samples for E. coli bacteria during four

monitoring periods at six targeted sites in an impaired watershed of the Broad River (SR 281 to Scull Shoal Creek
near Danielsville).

E. coli data from the first two targeted watershed monitoring periods (September and November 2008) indicated high
bacteria loads at Sampling Site #6 (Shiloh Creek at Manley Martin Road) upstream of the Georgia EPD listing station
(Sampling Site #3 at SR281). Downstream Sampling Site #2 (Scull Shoal Creek at David’s Home Church Road)
presented high bacteria loads during the September 2008 monitoring period.

During the January 2009 targeted watershed monitoring period, data from all six sampling sites showed counts within
the recommended healthy level. In May 2009, Sampling Site #6 again presented high E. coli levels, this time in the
extreme, while data from the other five sampling sites were within the recommended healthy level.

The USEPA recommends a single grab sample of 235 counts/100ml to be a healthy level of E. coli in a water body,
based on an iliness rate of eight people per 1000 after exposure.

Data were collected along Scull Shoal Creek, Shiloh Creek, and the Broad River from May through August 2011 as
part of the truncated Watershed Improvement Plan process, which eventually was reinitiated as a new Watershed
Management Plan (WMP) process. The 2011 data showed little contamination on the Broad River, but higher
numbers on the tributary creeks, especially Shiloh Creek.

2011 Sampling Data
Site  Site = Site Site = Site Site | Site
1 2 3 4 5 6 7

5.3.11 100 467 300 233 167 400 300
6.2.11 100 500 433 661 0 200 533
7.12.11 0 2333 367 33 100 233 367
8.9.11 0 2333 3166 633 300 700 300
*orange cells indicate samples that exceeded 235 colony-forming units

Date

I. Stream Reconnaissance — Field Notes

Based on the above data, the BRWA and Georgia EPD convened on Tuesday, February 10, 2009, to conduct a
stream reconnaissance along Scull Shoal Creek (Sampling Site #2) and Shiloh Creek (Sampling Site #6), walking
upstream from the sampling sites at David’s Church Road and Manley Martin Road respectively.

Scull Shoal Creek (Sampling Site #2)

First house (#3414) 75 meters upstream: Structure located across floodplain (Figure 6)
Entire flood plan mowed to the creek bank

Second house ¥ mile upstream: Structure located approximately 200 feet from creek bank (Figure 3)
Left fork tributary enters main stem approximately % mile upstream (Figure 5)
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Appendix B: Field Notes and Pictures

Shiloh Creek (Sampling Site #6)
Evidence of bulldozer grading up to creek bank (Figure 11)
Tracks disturbing channel from small spring or seep under rock (Figure 10)
Approximately 200 meters upstream from road crossing pasture fence crosses creek (Figure 5)
Obvious signs of cattle access to creek from pasture
Pasture on both sides of creek with 20+ cows visible (Figure 8)
Cow manure piles visible in creek (Figure 6)
Three large bones (presumably cattle bones, since much larger than deer bones) near creek (Figure 7)
Calf creep feeder located near creek (Figure 8)
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Appendix B: Field Notes and Pictures

lll. General Land Use Information

Scull Shoal Creek drainage area consists mostly of livestock and pasture. Any clear-cut timber areas
will be or have been planted for pasture. Pastures are spread with chicken litter from poultry houses
located throughout the watershed. Grazing livestock include cattle and horses.

Shiloh Creek receives local “clean-out” from poultry houses throughout drainage area. Livestock
have access to creek from pastures.

During discussions that took place during the initial preparation of the Watershed Improvement Plan
in 2011, it became apparent that, contrary to existing datasets, the predominant land use in this area
of the watershed is agriculture. According to stakeholders, bovine and poultry operations are the
primary forms of agriculture; this was confirmed upon field inspection.

IV. Recommendations

Georgia EPD recommends the five-mile impaired segment of Broad River from SR 281 to Scull Shoal
Creek for an FY2010 Extended Revision (Watershed Improvement Project) to address loadings of
bacteria from agricultural nonpoint sources.

The NEGRC is currently under contract with the Georgia EPD to complete a Watershed Management

Plan for this watershed by March 2014. The WMP will present data, model scenarios to reduce
contamination, and recommend potential BMP installations where appropriate.
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Appendix B: Field Notes and Pictures

Scull Shoal Creek at David’s Home Church Road — 02/10/2009

Fa . : o

Figure 1. Scull Shoal Creek: Roof turbine vent — Right bank looking U/S

¥

Figure 2. Scull Shoal Creek: Ag (poultry?) drainage ditch — Left bank looking U/S
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Figure 6. Scull Shoal Creek: Metal Trash Can — Right bank looking D/S
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Appendix B: Field Notes and Pictures

Figure 8. Scull Shoal Creek: Prop (vehicle?) imprint on road crossing — Looking D/S
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Shiloh Creek at Manley Martin Road — 02/10/2009

Figure 2. Shiloh Creek: Scum — Left to right bank looking U/S
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Bl W T N Y R
Figure 3. Shiloh Creek: Red algae — Right to left bank looking U/S

Figure 4. Shiloh Creek: Drainage ditch — Left bank looking U/S
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Figure 6. Shiloh Creek: Cattle manure — Left bank looking U/S
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Appendix B: Field Notes and Pictures

Figure 8. Shiloh Creek: Cattle access to creek — Left bank looking U/S
(Manure circled in yellow) (Calf creep feeder not visible on curve of bank at red circle)
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Figure 9. Shiloh Creek: Drainage ditch — Left bank looking D/S
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Figure 11. Shiloh Creek: Front loader disturbed soil while clearing culvert of debris - Looking D/S
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Appendix B: Field Notes and Pictures

Field Notes, 2013: NEGRC and BRWA representatives conducted additional field work, with the purpose of establishing
a new set of monitoring locations, in February 2013. The revised site list is based on previous sampling, field conditions,
and right-of-access to the stream. Photos and site descriptions follow.

1. Broad R. at SR 281 — access at Broad River Outpost boat ramp (No photo available)

2. Shiloh Cr. at Manley Martin Rd. (downstream) 3. Shiloh Cr. at US 29 (upstream)

3A. Shiloh Cr. upstream of US 29
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Appendix B: Field Notes and Pictures

4A1. Shiloh Cr. upstream of Holloway Rd. (downstream site at farm)

4A2. Shiloh Cr. upstream of Holloway Rd. (upstream site at farm)
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Appendix B: Field Notes and Pictures

4B. Shiloh Cr. along Long Peeples Rd.

4C. Branch of Shiloh Cr. at Holloway Rd. (ditch draining 5. Scull Shoal Cr. at Davids Home Church Rd.
wetland) (downstream)
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6. Scull Shoal Cr. at Duffell Martin Rd. (upstream)
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Appendix B: Field Notes and Pictures

7. Scull Shoal Cr. at Transco Rd. (upstream)

7A. Scull Shoal Cr. upstream of Transco Rd. (No photo available)

7A Alt. Scull Shoal Cr. at SR 191 (upstream)
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Appendix C

Education and Outreach Materials

This section includes handouts and mailers promoting reduction of bacterial contamination within
the watershed, as well as slides for a presentation that can be delivered to public and stakeholder
groups. The Northeast Georgia Regional Commission will provide original files upon request.
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Broad River Watershed
Management Plan

A five-mile segment of the Broad River in

Septic maintenance

Watering station

Madison County has been identified by the
State of Georgia as a contaminated stream.
Fecal coliform from “nonpoint” sources such
as agriculture, wildlife, or septic systems, is
present at levels that exceed state standards,
and the Georgia Environmental Protection
Division (EPD) has contracted the Northeast
Georgia Regional Commission to identify ways

to improve the watershed.

We have identified several “Best Management
Practices” (BMP) to reduce pollution over the
short-, medium-, and long-term. Please see
the reverse side for more information.

#% GEORGIA

DEPARTMENT OF NATURAL RESOURCES

NORTHEAST GEORGIA
REGIONAL COMMISSION

Broad River Filter strips

Broad River Watershed
Management Plan

A five-mile segment of the Broad River in

Septic maintenance

Watering station

Madison County has been identified by the
State of Georgia as a contaminated stream.
Fecal coliform from “nonpoint” sources such
as agriculture, wildlife, or septic systems, is
present at levels that exceed state standards,
and the Georgia Environmental Protection
Division (EPD) has contracted the Northeast
Georgia Regional Commission to identify ways

to improve the watershed.

We have identified several “Best Management
Practices” (BMP) to reduce pollution over the
short-, medium-, and long-term. Please see
the reverse side for more information.

#% GEORGIA

DEPARTMENT OF NATURAL RESOURCES

NORTHEAST GEORGIA
REGIONAL COMMISSION

Broad River Filter strips
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Appendix C: Education and Outreach materials

Limiting Livestock Access to Riparian Areas and Streams: Best implemented

Recommended Best when producers have alternative water sources and shade for their livestock.
Management Practices

These BMPs provide landowners and Vegetated Buffers/Filter Strips/Swales: Strips of vegetation next to an area of
others with tools to improve water runoff. The runoff flows over the buffer or filter strip to allow sediment to be
quality. EPD administers grant captured and allow water to be filtered into the soil.

funding to assist with

implementation, and other sources of ) A . . .
Monitoring Malfunctioning Septic Tanks: Ensure that septic tanks are

information, such as the County . . . . .
monitored and maintained through educational programs and/or ordinances.

extension office and the Georgia

Adopt-a-Stream program, are

excellent partners. Stackhouses for Poultry Litter: Poultry growers should consider stacking
broiler litter for more than eight days to eliminate fecal coliforms in runoff from
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These BMPs provide landowners and Vegetated Buffers/Filter Strips/Swales: Strips of vegetation next to an area of
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structures.
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Watering station

Broad River Watershed
Management Plan

A five-mile segment of the Broad River in %
Madison County has been identified by the x A
State of Georgia as a contaminated stream. &t
Fecal coliform from “nonpoint” sources

such as agriculture, wildlife, or septic

Appendix C:

Filter strips

Education and Outreach materials

Septic maintenance
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systems, is present at levels that exceed state standards, and the Georgia

Department of Natural Resources’ Environmental Protection Division (EPD)

Broad River

NEGRC

NORTHEAST GEORGIA
REGIONAL COMMISSION

has contracted the Northeast Georgia Regional

Commission to identify ways to improve the

watershed.

We have identified several “Best Management

Practices” (BMP) to reduce pollution over the

short-, medium-, and long-term. Please see the

reverse side for more information.
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Appendix C: Education and Outreach materials

Recommended Best Management Practices
For the Broad River Watershed

These BMPs provide landowners and others with tools to improve water
quality. EPD administers grant funding to assist with implementation, and
other sources of information, such as the County extension office and the
Georgia Adopt-a-Stream program, are excellent partners.

Limiting Livestock Access to Riparian Areas and Streams

Best implemented when producers have alternative water sources and shade for
their livestock.

Vegetated Buffers/Filter Strips/Swales

Strips of vegetation next to an area of runoff. The runoff flows over the buffer or
filter strip to allow sediment to be captured and allow water to be filtered into the
soil.

Monitoring Malfunctioning Septic Tanks

Ensure that septic tanks are monitored and maintained through educational
programs and/or ordinances.

Stackhouses for Poultry Litter

Poultry growers should consider stacking broiler litter for more than eight days to
eliminate fecal coliforms in runoff from land-spread litter.

Wildlife Management

Measures designed to address animal overpopulation or the concentration and
infiltration of specific animals into streams and lakes.

Educational Programs and Materials

Communities employ various methods to engage area residents, employers, and
developers on the rules and efforts behind maintaining local water quality.

Stream Crossings
Designed to protect water quality and erosion by concentrating animal and livestock
crossings over stable access points or structures.
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Appendix C: Education and Outreach materials

NEGRC #% GEORGIA

NORTHEAST GEORGIA DEPARTMENT OF NATURAL RESOURCES
REGIONAL COMMISSION

Top 10 Ways to Improve Your Watershed

Broad River, Madison County

1.Install BMPs on your property (see reverse)

2.Monitor and service your septic tank

3.Alert Georgia EPD, local code enforcement
personnel, or the county extension agent to any
potentially problematic activity

4.Talk with your neighbors and business partners
about healthy watersheds

5.Become a member of the Broad River Watershed
Association

6.Keep water in the streams by conserving it at home -
“dilution is the solution”

7.Pick up and dispose of pet waste

8.Test soil before you use fertilizer - you might not
need it

O.Buffer streams with native plants and swales

10.Participate in Georgia’s Adopt-a-Stream program
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Appendix C: Education and Outreach materials

Recommended Best Management Practices
For the Broad River Watershed

These BMPs provide landowners and others with tools to improve water
quality. EPD administers grant funding to assist with implementation, and
other sources of information, such as the County extension office and the
Georgia Adopt-a-Stream program, are excellent partners.

Limiting Livestock Access to Riparian Areas and Streams: Best
implemented when producers have alternative water sources and shade for
their livestock.

Vegetated Buffers/Filter Strips/Swales : Strips of vegetation next to an area
of runoff. The runoff flows over the buffer or filter strip to allow sediment to
be captured and allow water to be filtered into the soil.

Monitoring Malfunctioning Septic Tanks: Ensure that septic tanks are
monitored and maintained through educational programs and/or
ordinances.

Stackhouses for Poultry Litter: Poultry growers should consider stacking
broiler litter for more than eight days to eliminate fecal coliforms in runoff
from land-spread litter.

Wildlife Management: Measures designed to address animal
overpopulation or the concentration and infiltration of specific animals into
streams and lakes.

Educational Programs and Materials: Communities employ various
methods to engage area residents, employers, and developers on the rules
and efforts behind maintaining local water quality.

Stream Crossings: Designed to protect water quality and erosion by
concentrating animal and livestock crossings over stable access points or
structures.
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Appendix C: Education and Outreach materials

Broad River Watershed Management Plan

A five-mile segment of the Broad River in Madison County has been identified
by the State of Georgia as a contaminated stream. Fecal coliform from
“nonpoint” sources, such as agriculture, wildlife, or septic systems, is present
at levels that exceed state standards, and the Georgia Environmental
Protection Division (EPD) has contracted the Northeast Georgia Regional

Commission (NEGRC) to identify ways to improve the watershed.

Septic maintenance

The “Best Management Practices”

.| Broad River Watershed

listed on the reverse side represent \ ':F‘;'A- e kil
tools to improve water quality. EPD P CA i
administers grant funding to assist with \-““"""""' .
implementation, and other sources of A
Pter Strips information, such as the county _‘ ’
‘ extension office and the Georgia Adopt- AL

a-Stream program, are excellent
partners.

SN, ANNSoSTI S
OCLETHORPE S8 s

Broad River

Broad River Watershed Management Plan

A five-mile segment of the Broad River in Madison County has been identified
by the State of Georgia as a contaminated stream. Fecal coliform from
“nonpoint” sources, such as agriculture, wildlife, or septic systems, is present
at levels that exceed state standards, and the Georgia Environmental
Protection Division (EPD) has contracted the Northeast Georgia Regional

Commission (NEGRC) to identify ways to improve the watershed.

Septic maintenance

The “Best Management Practices”
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tools to improve water quality. EPD WP A, :

AL NOE
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Appendix C: Education and Outreach materials

Best Management Practices
For the Broad River Watershed

e Limiting Livestock Access to
Riparian Areas and Streams

e Vegetated Buffers/Filter Strips/
Swales

e Monitoring Malfunctioning
Septic Tanks

e Stackhouses for Poultry Litter
o Wildlife Management

e Educational Programs and
Materials

e Stream Crossings

More information on these BMPs, and
on the Watershed Management Plan,
can be found at www.negrc.org.

Best Management Practices
For the Broad River Watershed

e Limiting Livestock Access to
Riparian Areas and Streams

e Vegetated Buffers/Filter Strips/
Swales

e Monitoring Malfunctioning
Septic Tanks

e Stackhouses for Poultry Litter
o Wildlife Management

e Educational Programs and
Materials

e Stream Crossings

More information on these BMPs, and
on the Watershed Management Plan,
can be found at www.negrc.orq.
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Improving YOUR
Watershed

Broad River, Madison County (GA)

prepared by the Northeast Georgia
Georgia Department of Natural Re:

NEGRC#b GEORGIA

LTI G PR R

g =5t
e

What/Where are the Problems?

¢ Fecal coliform sources:
e Agriculture
* Residential
» Wildlife
¢ Two main locations of
significant “hot” spots:

e Shiloh Cr. between Manley
Martin Rd. and US 29

e Little Scull Shoal Cr.
between Coile Rd. and
Duffell Martin Rd.

—_——o
e = e =

"~ Top 10 Ways to HeIp Improve Your
Watershed

Install BMPs on your property
Monitor and service your septic tank

Alert Georgia EPD, local code enforcement personnel, or the
county extension agent to any potentially problematic activity

4. Talk with your neighbors and business partners about healthy
watersheds

5. Become a member of the Broad River Watershed Association

6. Keep water in the streams by conserving it at home - “dilution
is the solution”

7. Pick up and dispose of pet waste

8. Test soil before you use fertilizer - you might not need it
o. Buffer streams with native plants and swales

10. Participate in Georgia’s Adopt-a-Stream program

W N

Appendix C: Education and Outreach materials

g =
=

What’s Happening?

1997 data: fecal coliform | “/% . |
contamination - i

2002 data: listed as
impaired

2007: planning begins

2014: Watershed
Management Plan
(WMP)

———— .

==
B

What BMPs Should I Consrder?

Limiting Livestock Access to Riparian Areas and Streams
and shade i

Vegetated Buffers/Fllter Strips/Swales
Stps of frunoff. The runoff flows be captured and allow water to be filtered into the

Monitoring Malfunctioning Septic Tanks

Stackhouses for Poultry Litter
literand ed o loca eds. Pty growers

Pl
‘more than eigh in runof from land-spread ltter.

Wlldhfe Management
,,,,, aa d inflsation of dlakes,
E of

Educational Programs and Materials

Stream Crossings
Designed to p a croson

e

==
B

And One for Good Measure

1. Volunteer to give this presentation at
your organization’s next meeting!
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Appendix D

Suggestions for Working with Landowners/Managers

The following suggestions are presented in response to a stakeholder request to provide information
related to contacting and coordinating with landowners and property managers to initiate the BMP
implementation process.

1.

Prioritize landowners based on criteria outlined in the Watershed Management Plan, in
consultation with stakeholders and Partnership Advisory Council members listed in the WMP,
including the county extension agent, NRCS and GSWCC for agriculture; county code
enforcement officer and public health officials for septic systems; and chamber of commerce
officials, county planning and zoning staff, and other local organizations for business. Also, weigh
previous interest in water quality improvement and/or water resource management when making
decisions.

Do your homework: learn about the parcel(s) and how the landowner/manager makes use of the
land.

Find a mutual friend or contact and set up an appointment to meet, face-to-face, either on the
property or at a neutral location.

Ask questions, share information, and become better acquainted with the person and the
property.

Try to build a rapport and establish common ground (it is likely that you both want clean water,
even if for different reasons).

Talk informally about the different BMPs recommended in the Watershed Management Plan, and
suggest that the landowner/manager discuss which are most likely to be effective with the county
extension agent, the public health department staff, and/or other experts.

Mention, if applicable, that grant funding might be available to share the cost of implementing
recommended BMPs.

Leave with a list of to-dos for each party, and follow through on yours. These might include
further investigation of implementation techniques and/or costs, securing letters of commitment or
interest related to grant applications, assisting with grant application development processes, or
other tasks.
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Appendix E

Stakeholder List

Madison County Commission Chair

Madison County Commissioner (Dist. 2)

Madison County Commissioner (Dist. 4)

Madison County Clerk

Madison County Planning & Zoning Administrator
Madison County Cooperative Extension Agent

Madison County Code Enforcement Officer

Madison County Emergency Management Agency Director
Madison County Sherriff's Office Chief Deputy

Madison County Health Department

Madison County School System Superintendent

City of Comer Clerk

City of Danielsville Mayor

City of Danielsville Clerk

City of Carlton Mayor

Watson Mill State Park Manager

Madison County Chamber of Commerce Director

Broad River Watershed Association Chair and Board Members
Madison County Cattleman's Association

Georgia EPD Communication/Outreach Specialist
Georgia River Network Executive Director

Georgia River Network Policy Director

Georgia River Network Community Program Coordinator
Georgia River Network Watershed Support Coordinator
Oconee River RC&D Executive Director

Georgia Forestry Commission

Georgia Forestry Commission

Georgia Forestry Commission

NRCS Commerce

Anthony Dove
Dewitt Bond
John Pethel
Rhonda Wooten
Linda Fortson
Adam Speir
Jack Huff
Johnny Bridges
Shawn Burns
Beth Heath
Allen McCannon
Steve Sorrells
Todd Higdon
Susan Payne
Rufus Kidd
Jerry Cook
Marvin White
Various

Trey McCay
Mary Gazaway
April Ingle

Chris Manganiello
Gwyneth Moody
Jesslyn Shields
Tim Savelle
Brannon Carey
Carl Melear
Wesley Moss

Carol Boss
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Appendix F

Micro-watershed Tutorial

A tutorial presenting a “how-to” guide to constructing micro-watersheds similar to those found in
this WMP using ArcGIS follows.
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Appendix F: Micro-watershed Tutorial

MICRO-WATERSHED
DELINIATION FOR
DETERMINING
POTENTIAL ORIGINS
OF NON-POINT
SOURCE POLLUTION
IN RIVERS AND
STREAMS USING GIS

NORTHEAST GEORGIA REGIONAL
COMMISSION. ATHENS, GEORGIA
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Appendix F: Micro-watershed Tutorial

April 23, MICRO-WATERSHED DELINIATION FOR DETERMINING POTENTIAL ORIGINS OF NON-

2014 POINT SOURCE POLLUTION IN RIVERS AND STREAMS USING GIS

Adapted from University of Washington, School of Forest and Environmental Sciences, ESRM 250, Introduction to Geographic
Information Systems in Forest Resources, Lab titled “Exercise: Watershed Delineation” dated 5/24/2012 (last retrieved
3/11/2014).

http://courses.washington.edu/qis250/lessons/hydrology/exercise/

This analysis requires a computer with ArcMap’s Spatial Analysis Extension.

Load a Digital Elevation Model (DEM) into ArcMap. The higher resolution the DEM the better (e.g. 10
meter resolution is better than a 30 meter resolution, and so on). It should be in ERDAS Imagine (*.IMG)

format.
Q Untitled - ArcMap o[ @ ][ =
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-83.469 34.182 Decimal Degrees

Here a 10 meter DEM for Madison County, Georgia has been loaded. (The far east corner that is cut off
for now, this is in a different 7.5” Quadrangle boundary but is not necessary for this tutorial).

To begin delineating the micro-watersheds, a series of analyses needs to be done. This is done by a
series of automatic processes in ArcToolbox.

v.1.0
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Appendix F: Micro-watershed Tutorial

April 23, MICRO-WATERSHED DELINIATION FOR DETERMINING POTENTIAL ORIGINS OF NON-

2014 POINT SOURCE POLLUTION IN RIVERS AND STREAMS USING GIS

The first step is to render a Depressionless DEM. This gets rid of any anomalies in the DEM that might
not show flow.

Go to ArcToolbox->Spatial Analyst Tools=>Hydrology=>Fill

Load the DEM file into “Input surface raster”, accept default “Output surface raster” value, and click
“OK”. Generating this file may take a few minutes. The resulting file name will begin with “Fill_ “).

'Q microwatershed_tutorial.mxd - ArcMap o (@] =
File Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help
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Value 2
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ER=
= madisen_census_bndry

= Fill_img2
Value
High : 294,669
Low:124.47
At this point, the original DEM can be removed from the workspace as this is what the analysis will be

conducted from (it won’t hurt to leave it in, but turned off. Removing it helps keep the workspace less
cluttered).

v.1.0
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Appendix F: Micro-watershed Tutorial

April 23, MICRO-WATERSHED DELINIATION FOR DETERMINING POTENTIAL ORIGINS OF NON-

2014 POINT SOURCE POLLUTION IN RIVERS AND STREAMS USING GIS

The next step is to determine the flow direction, or what way water will flow when it hits the land at any
given point.

Go to ArcToolbox->Spatial Analyst Tools=>Hydrology—> Flow Direction

Load the “Fill” image (which was generated in the previous step) into “Input surface raster”, accept
default in “Output flow direction raster”, and click OK.

Km Flow Direction EI@

Input surface raster

| Fillimg2 | @
Output flow direction raster
C:\UsersKenny. MEGRDC \Documents\ArcGIS \Default, gdb FlowDir_Fill4 @

[ Force all edge cells to flow outward (optional)

Output drop raster (optional)

-

[ oK ] [ Cancel ] [Envircnments... ] [ Show Help == ]

The resulting file “FlowDir_"“ shows the compass direction to where which a point flows, and is coded

automatically as 1 (East), 2 (Southeast), 4 (South), 8 (Southwest), 16 (West), 32 (Northwest), 64 (North),
or 128 (Northeast

A
32 | 64 (128
«< »| 16 1
8 4 2

hd

(Univ. of Wash.)

The final image will look like this

v.1.0
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Appendix F: Micro-watershed Tutorial

O madison_l0m_dem.img

April 23, MICRO-WATERSHED DELINIATION FOR DETERMINING POTENTIAL ORIGINS OF NON-
2014 POINT SOURCE POLLUTION IN RIVERS AND STREAMS USING GIS
Q) microwatershed_tutorial.mxd - ArcMap [oZ =]
File Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help
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]
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-83.214 34142 Decimal Degrees

From here, generate a Flow Accumulation. This determines areas of high flow, or low spots to where
water is flowing.

ArcToolbox—> Spatial Analyst Tools=>Hydrology—=> Flow Accumulation

Load “FlowDir-“ in “Input flow direction raster”, accept defaults, and click OK. (This may take a couple of
minutes)

v.1.0
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April 23,
2014

Appendix F: Micro-watershed Tutorial

MICRO-WATERSHED DELINIATION FOR DETERMINING POTENTIAL ORIGINS OF NON-
POINT SOURCE POLLUTION IN RIVERS AND STREAMS USING GIS

& . .
w Flow Accurnulation

Input flow direction raster

| FlowDir_Fill4

Output accumulation raster

Input weight raster {optional)

C:\UsersKenny. MEGRDC\Documents\ArcGIS \Default. gdb \FlowAcc_Flows4

Cutput data type (optional)
FLOAT

| | | Cancel | |Enviru:unments... | | Show Help =
The result (“FlowAcc_“) will be something that looks like this—a completely black image:
Q) microwatershed tutorial.mxd - ArcMap o [ ][ =

File Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help
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Drawing - K O- A - <@ Ad

-83.214 3414 Decimal Degrees

To display the flow accumulation (which is essentially streams, creeks, rivers, etc.), reclassify the DEM.

v.1.0
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Appendix F: Micro-watershed Tutorial

April 23,
2014

MICRO-WATERSHED DELINIATION FOR DETERMINING POTENTIAL ORIGINS OF NON-

POINT SOURCE POLLUTION IN RIVERS AND STREAMS USING GIS
Right click=> Properties=>Symbology—> Classified—> Classify..

Under Classification, Method, select “Natural Breaks (Jenks)”, and Classes, “2”. Change Break Values to
5000 for the first, then accept the default for the second, click OK. It may automatically change
Classification Method” to “Manual”, but that won’t impact results.

Back in Layer Properties, change the first value (will probably show as black) to white by double clicking,
then selecting white on the color table. Change the second value to red by the same method. Click OK.

Classification @
Classification Classification Statistics
Method: ’Manual e ] Count: 13052016
Classes: 7 Minimum: 0
- Maximum: 6,073,009
L3l St Sum: 31,476, 752,830
[ — ] [ sampling ... ] Mean: 2,411.639925
Standard Deviation: 82,150.41164
Columns: 100 (= [7] show std. Dev. [] show Mean
S § Break Values
=2 o 5,000
w = 5,073,009
10000000~
5000000--
0 151825225 30365045 455475675 6,073,000
["]snap breaks to data values Cancel
Layer Properties @
| General I Source I Extent I Display | Symbolagy
Show: . =
Draw raster grouping values into classes
Unigue Yalues ‘ groupma [E]
Stretched Fields
Discrete Color Value <VALUE> Mormalization <None:
Classification
Manual CIasses[z v] [ Classify... ]
e -
Symbol  Range Label
[ Jo-s,000 0 - 5,000
s 000 - 5,073,009 5,000.000001 - 6,073,009
[ show dass breaks using cell values Display NoData as
[ Use hillshade effect 7.1
About symbology
oKk || Cancel || Aepy |

v.1.0
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Appendix F: Micro-watershed Tutorial

April 23, MICRO-WATERSHED DELINIATION FOR DETERMINING POTENTIAL ORIGINS OF NON-

2014 POINT SOURCE POLLUTION IN RIVERS AND STREAMS USING GIS

The resulting file will look something like this:

Q@ microwatershed tutorial.mxd - ArcMap o [ ][ =
File Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help
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-83.214 34146 Decimal Degrees

The resulting red line depicts streams, rivers, creeks, etc., basically anywhere water flows.

Compare the red lines just generated with a vector stream file (loaded in blue) in the image below. It’s
not an exact match— that depends much on precision of data, classification, etc.—but is pretty close
otherwise.

v.1.0
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Appendix F: Micro-watershed Tutorial

April 23, MICRO-WATERSHED DELINIATION FOR DETERMINING POTENTIAL ORIGINS OF NON-

POINT SOURCE POLLUTION IN RIVERS AND STREAMS USING GIS
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The next step is to determine the micro-watersheds based on sampling points. The sampling points
need to be loaded into ArcMap to determine what areas flow to them, thus making it possible to
determine with some confidence an area from where potential non-point source pollution is flowing.

Load sampling points (a simple adding a shapefile, geodatabase feature class, etc.). The sampling points
for this particular project are the green circles titled “points_10m”, but they can be named whatever
they need to be for the particular project.

v.1.0
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Appendix F: Micro-watershed Tutorial

April 23, MICRO-WATERSHED DELINIATION FOR DETERMINING POTENTIAL ORIGINS OF NON-
2014 POINT SOURCE POLLUTION IN RIVERS AND STREAMS USING GIS
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The next few steps will produce a file for the entire collection of sampling points, but will zoom into this
one for display purposes.

Note: It’s necessary at this point that the points lie along the processed DEM/Raster file, and not the
vector/stream data since the watersheds are determined not by vector, but rather raster data—in this
case, the recently processed “FlowAcc_” file . This may require moving the points slightly, and may be
good to generate a temporary file so as to not create location errors in the sampling points.

In other words, the green dot needs to be along the red squares, and not along the blue line, in the
white area, or so forth (see below)
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Now, it is necessary to convert the sampling point vector file to a sampling point raster file, or a pour
points file.

ArcToolbox->Spatial Analyst Tools=>Hydrology=>Snap Pour Point

Load the points shapefile (in this case, points_10m) into “Input raster or feature pour point data”, then
the flow accumulation file, “FlowAcc-“, file into “Input accumulation raster” Accept defaults, click OK.
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ﬂ Snap Pour Point EI@
Input raster or feature pour point data i
Ipoints_lﬂm ;I @
Pour point field (optional)
QBIECTID -
Input accumulation raster
| FlowAcc_Flowd =l @
Qutput raster
Ci\UsersKenny. MEGRDC \Documents\ArcGIS \Default. adb\SnapPou_shp4 @
Snap distance
U -
ok || Cancel | |Environments... || Show Help > |

This should run quickly—depending on the number of pour points. It’'s generated one raster cell for
each vector point (or one raster cell for each point in “points_10m”). The resulting file is something like
“SnapPou_"“. (Displayed as the blue cell below):

v.1.0

Page 45 of 51



Appendix F: Micro-watershed Tutorial

April 23, MICRO-WATERSHED DELINIATION FOR DETERMINING POTENTIAL ORIGINS OF NON-

2014 POINT SOURCE POLLUTION IN RIVERS AND STREAMS USING GIS

Q@ microwatershed tutorial.mxd - ArcMap o [ ][ =

File Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help

ODe2Es % |® o150 - BRI @0l - R

RQ@M@ e E-O /8@ 7B (2 MAS TR editor-| - » - fs o} B
& g = il [ IalllE g =) Show Name: PageText~ - | Labeling - & &4 é@ < @ &% [Fast

Table Of Contents ax

L

= 5 Layers B
B @ points 10m

£ O madison_rivers 2006

= B madison_census_bndry

- v EEREm
1

o
[
i

7]
E
[anmnlujv j] lumeag ﬂT Bojelen g} [samwaj alealn I:Tj]sa\uadmd yaays 1pa HI

mis
B @ FlowAcc_Flowd
<VALUE>
[0 - 5,000
1 5,000.000001 - 6,073,009
= O FlowDir_Fill4
Value
[l
[H
-
[SH
mi6
32
mes
mis
= O FillLimg2

Value
High : 204,669

Low 212447 ~|[@e |2« = J
Drawing~ K =0 %0 [+ A ~ @) Aral -0 +B I U A-He 2. e

It automatically assigns the number based on the OBJECTID field from the original point file. It may be
necessary to change this later to suit the project’s needs once a shapefile/feature class is generated for
the micro-watersheds. Now, all the processing has been done necessary to generating the micro-
watersheds.

ArcToolbox—>Spatial Analyst Tools> Hydrology—> Watershed

Load the Flow Direction raster (“FlowDir_“) into “Input flow direction raster”
Load the “SnapPou-“ into “Input raster of feature pour point data” (the raster version, not the vector
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version). Accept all defaults, click OK.
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The result will look like this (zoomed back out to a smaller scale):
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These are the micro-watersheds for this particular project.

This is what they look like zoomed into to a few of the smaller micro-watersheds (the light blue lines are
the streams/rivers/creeks, etc.).
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Point 15 receives all water from its micro-watershed (in grey) before flowing into 16’s micro-watershed
(dark green) which receives all water from its micro-watershed (dark green) before flowing into 10’s
micro-watershed (dark pink) which receives all water from its micro-watershed (dark pink) and so on
successively downstream eventually into the Broad River, eventually into the Savannah River, and
eventually into the Atlantic Ocean.

Extra Step 1—Exporting for further and future analysis:

Depending on project requirements, it may be necessary to export the raster file so you can access it
later:

Right click the “Watersh_* in the table of contents, then Data—>Export Data
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Set “Location” to wherever it would best suit the project, and otherwise accept defaults, click “Save”,
then “Yes” on the “Output Raster” window that shows up.

Export Raster Data - Watersh_Flow3

Extent
() Data Frame (Current)

[s2]

Spatial Reference

Extent {left, top, right, battom)

@ Raster Dataset (Original) leaatE sl el
@ Raster Dataset (Original
Selected Graphics (Clipping) Clip Inside © Raster Dataset (Original)
Output Raster ~
[ uze Renderer ["] square: Cell Size (o, cy): @ 9,759259799¢ 9,253259299
Force RGE Raster Size (columns, rows): () | 4374 2954
IUse Colormap MoData as: 127
Mame Property -
Bands 1 ﬂ
Fixel Depth & Bit
Uncompressed Size 12,45 MB

(-83.4044, 34.2757, -82.9994, 33.9994)

< |

Tl |

Location:

Mame:

Compression Type:

About export raster data

Z:\_Madison\EPD_WIP Broad R.\Watershed

MOME

Watersh_Flow31.ti  Format: | TIFF

Compression Quality 75

(1-100):

Save

-

Output Raster

| Would you like to add the exported data to the map as a layer?

Mo

/|

Yes

Extra Step 2—Exporting to vector file for easier analysis and calculations:

The project may necessitate conversion to a vector file to ease in analysis later on (area calculations,

selection, etc.).

ArcToolbox—> Conversion Tools=> From Raster-> Raster to Polygon
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Load the saved (or resulting) raster, the “Watersh_“ file as “Input raster”, put a convenient saving
location in the “Output polygon features” field, accept defaults, and click “OK”

K%, Raster to Polygon EI@

Input raster

| Watersh_Flow31.tif =l @
Field (optional)

Value -
COutput polygon features
Z:\_Madison\EPD_WIP Broad R\Watershedmicroshed_tutorial.shp @
Simplify polygons (optional)
[ K ] [ Cancel ] [Enuironments. i ] [ Show Help == ]

This generates a shapefile/feature dataset that can be used for overlaying on imagery, parcel data, or
whatever data may be available to determine, for example from this project, potential sources of water
pollution.

v.1.0

Page 50 of 51



Appendix F: Micro-watershed Tutorial

April 23, MICRO-WATERSHED DELINIATION FOR DETERMINING POTENTIAL ORIGINS OF NON-

2014 POINT SOURCE POLLUTION IN RIVERS AND STREAMS USING GIS

Example below: (zoomed to the micro-watershed for sampling point 15)

The area outlined in blue is Sampling Point 15’s Micro-watershed. If upon sampling point 15, you were
to notice a high level of pollutants, you could have a reasonable idea of what might be generating it, and
contact property owners to discuss mitigation opportunities with them.

In this case, if 15 showed high levels of

pollutants, notice there are several large,

*The data may or may not show high

CUIti\IatEd parCEIS (OUtIiﬂEd in grey) in the pollutants for this particular micro-watershed.

This is just an example. Further analysis,

micro-watershed. There MIGHT be cattle better imagery, site visits, local knowledge,

etc. will be necessary to help with confidence

farms where cattle are Wading in the determine causes of the pollutants.

stream here*

v.1.0

Page 51 of 51



	_WMP FINAL.pdf
	_appendices_all.pdf
	_appendices.pdf
	APP B_field notes 2009 and 2013.pdf
	TWMP appendix_2009 VFS and 2013 update.pdf

	APP C_all.pdf
	two-side handout postcard.pdf
	two-side handout full page.pdf
	top ten full page.pdf
	mailer postcard.pdf
	APP C_presentation.pdf



